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Genealogy is an education! 
Even though we have heard that 
several times, during the last few 
months, I feel like I have lived 
it!! When I look back on what I 

have been doing with my spare time…yes, it 
does happen on occasion…I am amazed at what 
I have learned. My focus for this month’s mes-
sage is to share the remarkable resources we 
have at our disposal right here in Vero Beach 
and our neighboring communities.  

My interest on the subject of DNA was peaked 
last fall when I attended the Federation of Ge-
nealogical Societies (FGS) Conference in Salt 
Lake City, Utah. Among the many wonderful 
lectures that I heard were several that focused on 
DNA. I began to understand the new world of 
‘genetealogy’ (ge-neh-tee-ol-o-gee), otherwise 
known as genetic genealogy. I met Megan 
Smolenyak Smolenyak, listened to her explana-
tion of the newest tool for genealogical research 
and of course, bought her book. (By the way, 
Trace Your Roots with DNA, Using Genetic 
Tests to Explore Your Family Tree by Mrs. 
Smolenyak Smolenyak can be found at the 
library.) There are many experts out there in the 
DNA world, however not everyone can commu-
nicate to the non-scientist genealogist: Megan 
can and does. By the time you read this, I will 
have attended the Ft. Pierce seminar on March 
18th and heard her speak again, this time sharing 
the day with my father. Since I need him to con-
tribute his DNA to start my family project…I 
wanted him to understand what it was all about. 
One more great experience on my DNA learning 

tract was a daylong DNA Conference in Sara-
sota on January 28th. There were four experts, a 
very nice lunch and a whole lot of good reading 
material. So, I continue to read and listen to all 
that I can on ‘genetealogy.’ I am looking for-
ward to sharing it all with you soon in the way 
of a seminar. Watch for the date and time.  

The next subject that I am learning about in 
more detail is the Timeline or Chronological 
Lifeline Chart. Yes, it seems so basic. Those of 
us who have attended any genealogy classes, 
read the how to books, or explored the internet 
hear that the timeline is a must. How many of 
you have actually prepared a timeline? “Well, I 
keep meaning to do it!!” A few weeks ago, I 
decided to actually do it, but I needed to find the 
best way to begin. Since I have plenty of drive 
time five days a week to and from work, I chose 
to find a tape to listen to. I browsed the old con-
ference tapes in the Genealogy Department 
and found one by Leslie Smith Collier, who 
spoke at a National Genealogical Society (NGS) 
Conference a few years ago. That is how I found 
out about the book, American Chronicle, which 
is found in the library reference section!! Who 
knew?! Now, as I browed through the tapes, I 
thought, “look at all this great material no-one is 
using!” I discussed this with my supervisor, you 
know who, and we came to the conclusion that 
IRGS Members can borrow the tapes. Next 
time you come in to work on the computer, ask 
me to show you another way to research and 
learn. Wow, did I say genealogy is an educa-
tion? YOU BET!! 
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Are genealogy problems getting you 
down or turning you off on your re-
search? It is time to call in the rein-
forcements!  

 
A panel of experienced genealogists, with help 
from your peers in the audience, may have an 
idea that could break your brick wall or solve a 
problem that has been on your mind for years. 

Write your problem on a piece of paper (brief 
and to the point). Drop it in the basket as you 
come in the door. By listening to other problems 
and hearing the suggestions that are offered, you 
may find a solution or another document to 
search for your own research. 
9:30 a.m. is our time to socialize with our 
friends. At 10:00 am will be the business meet-
ing followed by refreshments and the program. 
Contact Pete Kersey for questions and informa-
tion. Email: petenoel@aol.com.  

All Guests are Welcomed! 
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DAUGHTERS OF THE AMERICAN 
REVOLUTION (DAR), Treasure Coast 
Chapter Annual meeting will be April 10, 
2006, at Bent Pine Golf Club. Speaker will be 
1st Lt. Donna Lastra, US Army nurse, who has 
been in Iraq. Registration is at 11 AM, meet-
ing begins at 11:30 AM. Reservations are re-
quired by contacting Sondra Lee, 234-2608. 
Please mark Hot or Cold in the memo area of 
your check. For further information contact 
Cora Sjogren-Welch, Regent,at 567-9134 or 
email <csjogwel@digital.net> 
 
THE INDIAN RIVER CHAPTER, COLO-
NIAL DAMES XVIIC (CDXVIIC) will 
meet Saturday, May 13, 2006, at 11:00 AM in 
Eau Gallie.  Special guest will be Liz Sowden 
on quilts.  CDXVIIC is comprised of women 
18 years of age and older, who can prove lin-
eal descent from an ancestor who lived and 
served prior to 1701 in one of the original 
colonies in the geographic area of the present 
United State.  The membership of the Indian 
River Chapter is composed primarily of resi-
dents from Indian River & Brevard Coun-
ties.  Meetings are held four times a year and 
alternate between the two locales.  For infor-
mation or reservations for the May 13 meet-
ing, please contact Betsy Emerson at 772-569-
9678. 

 
DAUGHTERS OF THE AMERICAN 
REVOLUTION (DAR) Cora Stickney 
Harper Chapter, April 13, will welcome Jan 
Petri from Harbor Branch Oceanographic In-
stitute as their speaker. For more information 
on hearing this speaker, in Indian River 
County contact Pat Blaga 589-4290 and in Ft. 
Pierce contact Janel Cohen at 772-466-3450 
 
DAUGHTERS OF THE AMERICAN 
REVOLUTION (DAR)  The April meeting 
of St. Sebastian Chapter of the Daughters of 
the American Revolution will be held Satur-
day, April 22, 2006.  The program will be 
about one man's experience with a WWII ship.  
Hostesses will be Helen marsh, Phylllis John-
son and Jane Smith.  For more information, 
contact Elaine Johnson, Regent, at 589-4978. 
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11  IRGS Program 9:30 am to Noon and IRGS . Contact Pete Kersey Email: 
<petenoel@aol.com> 

13 Irish GIG will meet in Library History room 1-4 PM. Contact Bill Mur-
phy Email: <wclhmurphy@bellsouth.net> 

19  Quaker GIG 1-2 pm in the Ais Room. Contact Ellen Stanley  
Email: <Ellenestanley@aol.com>  

20 Swedish GIG - 1-3 pm in the Library History room. Contact Diane 
MacGowan <DMacgowan@aol.com> 

20 Polish GIG 3-5 pm in the AIS room. Contact Marge Putzke Email: 
<jmputzke@bellsouth.net> or 569-0132 

27 French Canadian GIG 1-3 pm in the AIS room. Contact  
Donna Nightingale Email: <Donnawalt@aol.com> or 978-0107 

5 Beginning Genealogy - 1-3 PM Ais Room. Contact Diane MacGowan 
<DMacgowan@aol.com> 

12 Beginning Genealogy - 1-3 PM Ais Room. Contact Diane MacGowan 
<DMacgowan@aol.com> 

Computer Special Interest Group (SIG) 
The PAF5 computer GIG will continue to meet the 2nd. Fri. of each month in 
the Library History Room. Time: 10:00 AM Pre-Meeting questions can be an-
swered by John Hendricks [562-4362 <jshendricks@earthlink.net>] or John 
Getz [978-1237 or <loisbruckheimer@comcast.net>] 
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 The word “family” takes on a 
whole new dimension when you’re the 
first born of ten children.  In fact, it’s the 
most important word in Marg Putzke’s 
vocabulary. 
 
           Born Margaret Mary Zientarski, 
she was raised in the little Southwestern 
Michigan town of New Buffalo. She 
earned her BA from Western Michigan 
University and her MA from Michigan 
State.  Marg taught high school English 
and theatre in her high school alma mater 
for 10 years before relocating to the 
warmer climates of Vero Beach.  She and 
her husband, Jon have been active in thea-
tre and Marg’s interest in costumes led her 
to open Creative Costumes in 1983.  Marg 
is also a pianist/organist and when her part 
time job became a full time position, she 
sold her costume business and dedicated 
all her time to music.  She now plays at 
Holy Cross Catholic Church which finally 
allowed her time to investigate a meeting 
at IRGS.  She was hooked during her first 
meeting when she heard Cindy Davis give 
her reports. Since joining, Marg has 
worked on the Programs Committee and 
heads up the Polish GIG. 
 
             Marg became interested in geneal-
ogy early in her life.  She loved her patient 
German grandfather, the tasty cooking of 
her Bohemian grandmother and the rich 
traditions of her Polish grandparents. As 
she grew older and her family started dy-
ing off, she realized the responsibility of 
passing down the legacy she had acquired. 
 
           All of her immigrant ancestors set-
tled in Chicago and eventually moved to 
the little town of New Buffalo.  Marg’s 
husband, Jon is also from New Buf-
falo…in fact they’ve known each other 
since first grade.  This has made the dig-
ging a little easier than for most genealo-
gists since much of the research in this 
country is in one familiar locality.  

 
           However the hunger for the “old 
country” did not die with her ancestors.  
Marg and Jon are now preparing for a trip 
to Poland, Germany, and the Czech Re-
public in 2007 where the dig may be more 
challenging.   
 
            One of Marg’s favorite success 
stories involves her Bohemian great 
grandparents.  Richard and Bessie Hlina 
came to the states from Blovice, Bohemia 
in 1892.  Richard was a saloon-keeper in 
Chicago who was killed in an accident on 
his way home from work.  He was thrown 
from a horse-drawn carriage on the 4th of 
July when some fire-crackers spooked the 
horse.  His wife was left with three of 
their children and six step-children.  She 
died shortly after of exhaustion.  They are 
buried in the Bohemian National Ceme-
tery in Chicago.   

                   In 1970, Marg’s mother vis-
ited the cemetery and took pictures of the 
tombstone.  With those pictures in hand 
and the cemetery records, Marg tried to 
find the graves in 1990.  Something was 
missing…the tombstone.  The cemetery 
secretaries brushed it off with comments 
like, “we don’t remove tombstones.”  So 

the mystery began to unfold as she called 
and wrote all the living relatives.  No one 
really seemed interested.   
 
               Finally, Marg took all the pic-
tures and maps and records and sent cop-
ies to the superintendent.  (Keep in mind 
that Bohemian National is a huge, historic 
cemetery.)  One day in the middle of the 
afternoon, the superintendent called her in 
Florida and reported that he had taken all 
the evidence to the site and sure enough, a 
large tree which is recorded in all the pho-
tographs, had a broken branch directly 
above the grave.  He assumed it had fallen 
and destroyed the tombstone.  So he of-
fered to replace it for free.   
 
               That was a moment of shear ec-
stasy…when her efforts finally pay off big 
time and she knew that her ancestors 
would be immortalized with a marker on 
their grave.  What if nobody had ever 
snooped?  What if nobody ever cared 
enough to ask questions or dig up infor-
mation?  What if their grave was forever 
lost to their future descendents?  What if 
that branch on the tree was forever bro-
ken? 
 
             Marg is making a trip to that 
gravesite in May and she will meet some 
helpful “cousins” for the first time at the 
grave of their mutual ancestor. This is 
what genealogy is all about. 
 
                  Because she has inherited so 
many family photos, Marg investigated 
their preservation.  She is now a consult-
ant for Creative Memories and takes pride 
in sharing her knowledge with any one in 
need of help sorting and organizing those 
heirloom photos and the memories at-
tached to them.  She has made it her life’s 
mission to tell her families’ stories in 
keepsake albums as she continues to re-
search Zientarski, Ciszewski, Aigner, 
Hlina, Putzke and Abel.   

It's a pleasure to share one's memories. Everything remembered is dear, endearing, touching, precious. At least the 
past is safe—though we didn't know it at the time. We know it now. Because it's in the past; because we survived. 

 
--Susan Sontag, 1933-2004, author and critic, in American Review, New York, September 1973 
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Part two of this series covers several of the new genealogical 
programs and software.  These products offer timeline charting 
as part of the program's capability.  Some of the more popular 
examples used by our local genealogists are listed below: 
 

Family Tree Maker 2005  
The timeline view in Family Tree Maker 2005 places life-spans 
on a backdrop that marks off decades. Users have the option of 
adding historical timelines to the chart. Categories of historical 
events that can be added include Arts, Asia, Economics, Europe, 
Military, Politics, Religion, Technology, United States, and the 
World. Any or all of the categories can be placed in a timeline at 
the bottom of the chart or interspersed through the body of the 
chart.  
 
Timelines in FTM 2005 are fairly basic. People are listed in 
chronological order. Users have the option of including any in-
formation they have entered on the family page. All the indi-
viduals in a database can be included, or users can select ances-
tors and/or descendants of a person. People can also be chosen 
individually to be included or excluded from the timeline view. 
Users can alter the format, including the interval of the tick 
marks (the default is one tick mark for every two decades), the 
flow of the years (left to right or right to left), and the appear-
ance of fonts and boxes.  
 
To access timeline view in FTM 2005, click on "View," then 
click on "Timeline" near the bottom of the list. The buttons on 
the right side of the timeline view control data and formatting 
options. Once the timeline has the desired features, users can 
save the view by clicking at the top on "File," then "Save Time-
line as." Saved timelines can be viewed later by going to 
File>Open Saved View and then clicking on the name of the 
desired timeline. 
 

Generat ions L iberty Edi t ion 8.5  
(with EasyTree 8.5 and EasyChart 8.5) has a timeline chart fea-
ture. It does not have the pre-set events that users can incorpo-
rate as in FTM. Generations uses what it calls "perspective 
events." Users can add these events, as well as change format-
ting for them on the chart, save them as a set, and use them 
again in other timelines.  
 
The individuals on the chart can be arranged in several ways–
sorted by birth date, death date, age, last name, or descendants. 
The descendant option arranges the individuals as they would 
appear on a traditional descendant chart with subsequent genera-
tions being indented. The use of color also assists in sorting out 
the generations.  
 
Users can create a timeline by going to the family card window 
of the desired couple. At the top of the screen, click 
Charts>Timeline Chart. Several choices are offered at this point, 

including whether to include all individuals in the database, 
marked individuals only, or descendants of the current couple. 
Timelines can be saved for future viewing. While in the Easy-
Chart section, choose File>Save and give the timeline a name. 
This timeline can then be viewed again in EasyChart using 
File>Open. 
 

Family Orig ins 9.0  
Family Origins 9.0 has two types of timelines: a chart, similar to 
what has been discussed previously, and a text-based list of 
events. Unlike the other programs discussed so far, Family Ori-
gins does not have the ability to add historical events, nor can a 
timeline report be saved for future use.  
 
The chart type of timeline can be found under Reports> Time-
line. Users can adjust the format of the names, fonts, and colors 
used in the horizontal bars, as well as choose whether to include 
the entire database or selected people. If the user opts for 
"selected people," upon clicking "create" a new menu will ap-
pear. From here, users can select who to include in the timeline. 
There are many options, including individuals (even unrelated 
ones), descendants and/or ancestors of an individuals, etc. Indi-
viduals can also be excluded from a timeline.  
 
The descendant and ancestor options allow the user to set the 
number of generations and to include spouses. Choosing to in-
clude ancestors of an individual also gives options on including 
just the direct line, the direct line and their spouses, or all of the 
ancestors and their collateral lines. Similar options exist for a 
timeline created for descendants of an individual. 
 
The second type of timeline that Family Origins 9.0 can gener-
ate is a text-based list. Rather than displaying a person’s life 
against tick marks representing decades, it gives a chronological 
list of all the events entered for that person, either as an individ-
ual or with a family. It can be generated from Re-
ports>Lists>Timeline List (Family) or Reports>Lists>Timeline 
List (Personal). 
 

Legacy 3.0  
The timeline features of Legacy 3.0 are similar to other pro-
grams, although it is in black and white, rather than in color. 
You can save the timeline report, but you can’t add historical 
events.  
 
To find the timeline, go to Reports>Select a Report and then 
click on Timeline. The timeline report menu gives the option of 
including either the ancestors or descendants of a particular per-
son. It defaults on the person highlighted on the family view, 
although users may select a different individual with "Record 
Selection" at the bottom of the timeline menu. Users can define 
the number of generations to include. The Report Options button 
gives additional options, such as whether to include the data of 
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living persons. Living persons can also be listed as "living" 
rather than by name. 
 

The Master Genealogist  v4.0d  
The Master Genealogist 4.0d handles timelines a bit differently 
than the other programs. Rather than showing life spans as bars 
on a chart, TMG’s timelines emphasize the events in a person’s 
life and historical events.  
 
Version 4.0d comes with 41 different historical timelines. There 
is also a function in TMG that allows users to create a custom-
ized timeline. A common custom timeline outlines dates of 
county creations where the family lived. Wholly Genes, makers 
of The Master Genealogist, encourages users to share the time-
lines they create and to submit them to the Wholly Genes Web 
site. All of the latest timelines are included with version 4.0d.  
 
Users can select any number of timelines and apply them to spe-
cific individual(s) in the database. If applied to the entire data-
base, the timeline will show only those events near a person’s 
life. For example, if a person was born in 1935, it would not 
show the beginning and ending of the American Civil War 
(1861—65).  
 
To add a timeline, either globally or to an individual, select 
Tools>Timeline, then Globally Selected (to apply to the entire 
database) or Locked to this Person (to apply to the person cur-
rently in the person view). To see the historical events appear in 
person view, click on Tools>Timeline>Status or use the timeline 
button on the left side of the screen. Having timelines appear in 
the person view will slow down performance. 
 
A printed timeline can show the historical events in addition to 
the events entered for that person. To print this report, click Re-
port>Individual> Detail>Individual Detail. To include the his-
torical timelines, go to the options 2 tab and select Timelines: 
Globally Selected and/or Locked to Each ID. Users have the op-
tion of generating this report for a group of people using the fo-

cus tab. 
 

Genel ines 1.2P 
Genelines is a utility software program designed specifically to 
create timelines. It can read GEDCOM files as well as files di-
rectly from Family Tree Maker (through version 8.0) and Per-
sonal Ancestral File (versions 3.0 through 5.0). It has three sets 
of historical events included with the program, with more avail-
able at the Progeny Software Web site. Progeny also has a free 
add-on program for Genelines that allows for easier creation of 
new history files, which Progeny encourages users to submit for 
sharing on its Web site.  
 
Genelines has two types of charts: biographical and relationship. 
The biographical charts –individual life bar and comparative life 
bar – use events from the person’s life. Default categories of life 
events include health, occupation, relationship, religious, and 
residential. Users can add other categories. The individual life 
bar shows the events for one person, while the comparative life 
chart simultaneously shows the life bars for two people (who 
need not be related). Neither type of biographical chart will show 
historical events. 
 
The relationships charts – pedigree, family group, and direct de-
scendant – take the traditional charts that family historians are 
accustomed to and show them in a timeline format. These types 
of charts allow the insertion of historical events. 
Genelines is very flexible in allowing users to change formats 
and colors. Individuals can be moved around on the chart, if de-
sired. This should be done judiciously however, as it could con-
fuse relationships. 
 
Although genealogists have wholeheartedly embraced software 
for the creation of ancestor charts and family group sheets, the 
other types of reports available, including timelines, should be 
explored. Timelines can give a whole new look to data, making it 
possible for researchers to develop new strategies for researching 
their ancestors.  

This image 
can be 

found at:  

http://tlc.ou
sd.k12.ca.us
/~jreese/tim

eline.jpg 
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Original patentees who purchased land within the boundaries of Indian River County. Many names appear twice because they re-
ceived patents on other land purchases. It is interesting to note where they are from and the other names that were also listed with 
them. All patentees filed claims at the Gainesville land office except for Allen Estes who received his in Tallahassee.  

T= Township is always South; R= Range is always East; S= Section 

Benson, Henry Warrington, ENG T31, R39, S7 20 Mar 1885     6228 

Benson, Henry Warrington, ENG T31, R39, S21 9 May 1885     7659 

Benson, Henry Warrington, ENG T32, R9, S3 9 May 1885     7660 

Benson, Henry Warrington, ENG T31, R39, S23       7782 

Beugnot, Henry E.   T31, R39, S19 13 Apr 1916   Homestead 06541 

Bowler, Robert Brevard Co., FL T31, R39, S3 4 May 1891     10578 

Bradford, Oscar   T31, R39, S18 25 Jul 1916   Homestead 06215 

Brown, William   T32, R39, S22 
T32, R39, S23 

28 Nov 1896   Homestead 12610 

Brownell, Mary A. Benton Co., IA T31, R39, S23 3 Jun 1885     8983 

Bryan, Needham C. Brevard Co., FL T31, R39, S4 10 Apr 1885     6970 

Buchler, John Benton Co., IA T32, R39, S15 9 May 1885     7780 

Burch, William E.   T31, R39, S29 
T31, R39, S32 

7 Dec 1917   Homestead 07249 

Cain, Dempsey Brevard Co., FL T31, R39, S3 
T31, R39, S10 

4 May 1891     10577 

Camp, Benjamin F. Alachua Co., FL T31, R39, S20 
T31, R39, S29 

16 Jun 1888 Camp, John S., 
Robert J., William, 
Paul J., James T. 

  11755 

Camp, Benjamin F. Alachua Co., FL T31, R39, S17 
T31, R39, S20 
T31, R39, S21 

13 Feb 1884 Camp, John S. 
Camp, Robert J. 

  3759 

Camp, James See Camp, Benjamin          

Camp, John Alachua Co., FL T31, R39, S20 
T31, R39, S29 

16 Jun 1888     11755 

Camp, John S. Alachua Co., FL T31, R39, S17 
T31, R39, S20 
T31, R39, S21 

13 Feb 1884     3759 

Camp, Paul See Camp, Benjamin         11755 

Camp, Paul D. Hertford Co., NC T31, R39, S7 16 Jun 1888     11765 

Camp, R. J. Alachua Co., FL T31, R39, S7 
T31, R39, S17 

13 Feb 1884 Camp, A. J., Ben-
jamin F, John S. 
Paul D., James, W. 
N., McSpeirs, H.D. 

  3758 

Camp, R. J. And 
Brothers 

Alachua Co., FL T31, R39, S17       3888 

Camp, Robert J. See Camp, Benjamin         11755 

Camp, William See Camp, Benjamin   16 Jun 1888       
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MICHIGAN COUNTY HISTORIES 
<http://www.hti.umich.edu/m/micounty/> 
“The Michigan County Histories collection is a collaborative 
effort of Michigan's Council of Library Directors. The collection 
is projected to provide access to 192 histories dating from 1866 
to 1926. There are 202 volumes in 170 titles currently online.” 
*************************************************** * 
UNITED STATES RAILROAD RETIREMENT 
BOARD <http://www.rrb.gov/mep/genealogy.asp > 
“The U.S. Railroad Retirement Board administers a Federal re-
tirement benefit program covering the nation's railroad workers.  
The records it maintains deal primarily with the administration 
and payment of these benefits.  The Board will provide informa-
tion from its records on deceased persons for the purpose of ge-
nealogical research.  However, it will not release information on 
persons who are still living without the written consent of that 
person.” 
*************************************************** * 
ARCHIVEGRID (Free until May 31) 
<http://archivegrid.org/>   
“ArchiveGrid is an important destination for searching through 
historical documents, personal papers, and family histories held 
in archives around the world. 
 
Thousands of libraries, museums, and archives have contributed 
nearly a million collection descriptions to ArchiveGrid. Re-
searchers searching ArchiveGrid can learn about the many items 
in each of these collections, contact archives to arrange a visit to 
examine materials, and order copies.” 
*************************************************** * 
BIOGRAPHICAL DIRECTORY OF THE 
UNITED STATES CONGRESS 1774 - 2005 
<http://www.gpoaccess.gov/serialset/cdocuments/hd108-
222/index.html> 
The Continental Congress, September 5, 1774 to October 21, 
1788 and the Congress of the United States, From the First to the 
One Hundred Eighth Congresses, March 4, 1789 to January 3, 
2005, Inclusive. Closing date of compilation, January 3, 2005. 
Includes biographies of every one serving in the Continental 
Congress or the U.S. Congress from 1774-2004. 
*************************************************** * 
TAX PHOTOGRAPHS OF NEW YOUR CITY 
B O R O U G H S ( E V E R Y  H O U S E ) 
<http://www.nyc.gov/html/records/html/taxphotos/home.shtml#
order>   
From the Web site: “Between 1939 and 1941, the city photo-
graphed every house and building in the five Boroughs. Copies 
of these unique images are now available for purchase. 
HISTORY OF THIS COLLECTION: During the 1930's, lo-
cal governments began to use photography as a tool for apprais-
ing real property for taxation purposes. New York City was the 
largest municipality to adopt this technology. The result was 
720,000 35mm black and white images of every property in the 

five Boroughs. The Municipal Archives acquired the original 
negatives (20,000 strips of film stored in cans) in the early 
1980s. The original film stock was nitrate and some negatives 
had begun to deteriorate and exhibit signs of "redox" blemishes 
(which look like giant snow flakes). With grant funds from fed-
eral, state, and private sources, the Archives duplicated the origi-
nal negatives so that new prints can be produced and copied 
them to microfilm so that patrons can easily and safely view the 
entire collection.” 

If you are from the New York Area, you are going to love this 
site. It has many photographs from aerials to street scenes to the 
waterfront. In addition, this is the web site to order vital records. 
Now if only all vital record offices would do this!! 

*************************************************** * 

INDEX TO MAINE FAMILIES IN 1790 NOW 
ONLINE < http://www.rootsweb.com/~megs/families.htm> 

The Master index to the first nine volumes is available in PDF 
format. All volumes are available in the library. “The goal of the 
Maine Families in 1790 series is to document all of the families 
living in Maine at the time of the 1790 census.  The intent is to 
establish these families through accurate and well-documented 
summaries, providing a basis for further research.”  

2�9��������#���-�6�#�5��637�

""""""""""""""""""""""""""#�������������$�
�""""""" """""""""""""""""""�



���������		
����
���
���������
�������������������� 
���

�

������� �
���
���������
�����������������������������

4�3-��#��5�9���6�� �
#�$����%��&��������'��������� ������� �������(�
���
���������)�*��'��

�2�<����� +�,���+--�����������)���$-.*��
���
-������
���	0������ ���
�)��*�'
�����,���+--�����������)���$-.*��
���
- ����-���,*�
�����,�$� �

NEW BOOKS 
 
ALABAMA 
Family Maps of Fayette County 
A History of Baldwin County 
Old Land Records of Jackson County 
One Hundred Fifty Years in Pike County, 1821-1971 
Historical Sketches of Clarke County 
BARBADOS 
Tracing Ancestors in Barbados, A Practical Guide 
Barbados and Scotland Links, 1627-1877 
CANADA 
The Church of Saint Paul in Halifax, Nova Scotia: 1749-1949 
The History of the County of Bruce and of the Minor Munici-
palities Therein, Province of Ontario 
History of Perth County to 1967 
Historic Saskatoon 
A History of Moncton,, Town and City 1855-1965 
DELAWARE 
Friends School in Wilmington 
ENGLAND 
The Marlborough Country 
FAMILY HISTORY 
Finley McKee, Eliza Ann McKee, A Character Sketch, with 
Reminiscences of Scenes and Incidents, Together with a Brief 
Biography of Each of Their Children 
FLORIDA 
Vero Beach High School Graduates, Class of 2004 
The Arrowhead, 1946 
Indian River County Plat Directory, 2003 Edition 
Biscayne National Park, Historic Resource Study, January 1998 
The Dugout of 1938, Florida Military Academy, St. Petersburg 
The Truth about Florida 
Weird Florida II, in a State of Shock 
Casa Florida, Spanish-Style Houses from Winter Park to Coral 
Gables 
GENERAL 
Official Register of the United States, 1944 
Pioneers in the Settlement of America, (assorted parts) 
German-American NAMES, 3rd Edition, (replaces 2nd Edition on 
shelf) 
Magna Carta Ancestry: A Study in Colonial and Medieval Fami-
lies 
The Way of Duty, A Woman and Her Family in Revolutionary 
America 
GEORGIA 
Inventory of the County Archives of Georgia, No. 88 Lee 
County (Leesburg) Vol 1, Historical Sketch 
Quaker Records in Georgia, Wrightsborough 1772-1793, 
Friendsborough 1776-1777 
History of The First Baptist Church of Christ at Macon, 1826-

1968 
Alumni History and Directory of Emory University 
Brooks County, Echoes of its People 
ILLINOIS 
Year Book of the Illinois Society Sons of the American Revolu-
tion  
 INDIANA 
Family Maps of Kosciusko County 
IOWA 
A Stranger in a Strange Land, the Story of a Dutch Settlement in 
Iowa 
KANSAS 
The Story of Alexanderwohl 
KENTUCKY 
Early Fleming County Kentucky Pioneers 
LOUISIANA 
Family Maps of Caddo Parish 
MAINE 
The Franco-Americans of Biddeford 
MASSACHUSETTS 
Historic Fall River, Donated by Pat Gallagher 
Fall River, A Pictorial History, Donated by Pat Gallagher 
Images of America, Lawrence  
Nantucket’s 300 Years 
Cape Cod Stories and Pictures 
MISSISSIPPI 
Family Maps of Winston County 
MISSOURI 
Family Maps of Sullivan County 
NEW HAMPSHIRE 
Northern New Hampshire Graveyards and Cemeteries 
NEW JERSEY 
Old Lawrenceville, (Formerly Maidenhead, New Jersey), Early 
Houses and People 
The Journall of the Procedure of the Governor and Councill of 
the Province of East New Jersey from and after the First day of 
December 1682 
NEW YORK 
The Settlers of the Beekman Patent, Dutchess County  
Perry, New York AS IT WAS and IS, 1776-1976 
The Centennial History of Saint Bartholomew’s Church in the 
City of New York, 8135-1935 
Westmoreland, 200 Years 1776-1976 
Cradle of the Middle Class, The Family in Oneida County, 1790-
1865 
A History of the Town of Yates, in Orleans County 
NORTH CAROLINA 
Heritage and Homesteads, The History and Architecture of Gran-
ville County 
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OHIO 
Columbiana County Ohio Marriages 1800-1870, and Other Evi-
dence of Marriages 
The Church in Northern Ohio and in the Diocese of Cleveland, 
from 1817 to September 1887 
Ohio State History of the Daughters of the American Revolution, 
Vol. II 
Men of Old Miami, 1809-1873, A Book of Portraits 
PENNSYLVANIA 
Coverlets of the Pennsylvania Germans 
A Contribution to Western Pennsylvania Pharmacy 
A History Salem United Church of Christ (German Reformed) 
Harrisburg from 1787to 1988 
Annual Report of the Pennsylvania Commission of Soldiers’ 
Orphan Schools, year ending may 31, 1898 
History of the Methodist Church in Carlisle, Pa 
History of the Presbytery of Erie 
Memorial Lutheran Church 
History of the Early Settlement of the Juniata Valley 
Centennial History of  The Shadyside Presbyterian Church 
History of St. James Evangelical Lutheran Church of Gettysburg, 
Penna, 1775-1921 
A History of Athletics at Pennsylvania, 1873-1896 
Zion Reformed Church, United Church of Christ, Chambersburg 
POLAND 
Polish Political Emigres in the United States of America, 1831-
1864 
Index to Polish American Family Biographies  
The Rest is Silence, The Powazki Cemetery in Warsaw 

RELIGION 
Quakerism on the Eastern Shore 
Baptist Biography, Vol. 1-3 
History of the Puritans 
Religion on the American Frontier, 1783-1840 
RHODE ISLAND 
Coventry Tax Book, 1941 
SWEDEN 
Swedish Exodus 
TENNESSEE 
A History of One Hundred Years of St. John’s Episcopal Church 
in Knoxville, 1846-1946 
“It Is A Goodly Land”, A History of the Mansker’s Station, 
Goodlettsville Area 
TEXAS 
The Millennium History of Panna Maria, The Oldest Polish Set-
tlement in America, 1854-1966 
The First Century of Scottish Rite Masonry in Texas, 1867-1967 
VERMONT 
A History of the Town of Orwell, Vermont 
VIRGINIA 
Jamestown Pioneers from Poland 
Ye Kingdome of Accawmacke or the Eastern Shore of Virginia 
in the 17th Century 
WEST VIRGINIA 
History of the West Virginia State Teachers’ Association 
Index to West Virginiana 
Descendants of First Lot Owners Morgan’s Town-1785 
Greenbrier Pioneers and Their Homes 
WISCONSIN 
Family Maps of Washburn County 


�����������������������

Have you seen the term “partner” on the census? 
The instructions by the enumerator were as follows: 
1910 Population 
Instructions for Filing This Schedule [1910] Name and Relation 
105. If two or more persons share a common abode as partners, 

write *head* for one and *partner* for the other or others 
 
*************************************************** * 
 
THE NATIONAL ARCHIVES - BUT WHICH 
COUNTRY? 
Have you performed a search on a search engine for the National 
Archives and was confused by what you saw on the web page? 
Could it by that you are in the wrong country? Many countries 
use the same term for the place where we keep our important 
federal records and call it the National Archives. For example: 

 
United Kingdom:  <http://www.nationalarchives.gov.uk/> 
United States: <http://www.archives.gov/> 
Australia: <http://www.naa.gov.au/> 
India: <http://nationalarchives.nic.in/> 
Scotland: <http://www.nas.gov.uk/> 

South Africa: <http://www.national.archives.gov.za/> 
Japan: <http://www.archives.go.jp/index_e.html> 
Norway: <http://www.riksarkivet.no/english/about.html> 
Ireland: <http://www.nationalarchives.ie/> 
 

*************************************************** * 

HIBISCUS FESTIVAL - APRIL 22 
IRGS needs your help. We need volunteers to 
help staff the table where we will be display-
ing information about the society and the li-
brary. The festival is an excellent opportunity 
to reach out to the community and provide 
them with family history information. If you 
can help, please call or email Patti Kirk 
<ckirkfirst@comcast.net> 567-7463 or Donna 
Nightingale <DonnaWalt@aol.com> 978-
0107  

�
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USING SCANNED IMAGES IN RESEARCH 
BY CJ MADIGAN 

Professional photographers place strips of film on photographic 
paper and expose it, creating a one-page record of all the images 
on that roll of film. In film processing that is called a contact 
sheet; its digital equivalent is often called an index print. Various 
programs give you options of how many images to lay out on a 
page and what information to include with each image. 
 
By first organizing your digital images into albums or folders 
with a program such as iPhoto [Mac] or Adobe Photoshop Al-
bum [Windows], you can create an index print that includes all 
the photos for one branch of the family or one location.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
These programs, referred to as digital asset management soft-
ware, give you significant flexibility in organizing and reshuf-
fling your images into different configurations. 
 
Most image editing programs have some capacity—usually 
called filters—for turning photographs into artistic renderings, 
By turning an image into a drawing [often the filter’s name has 
the word “edges” in it], you can reduce a face to its more ele-
mentary shapes. You might then compare faces to find family 

resemblances or to 
determine if two im-
ages are of the same 
person at different 
points in time.  
 
One of the advantages 
of scanning photo-
graphs—as well as 
other documents and 
e v e n  t h r e e -
dimensional objects—
is that the resulting 
digital image is, in the computer’s mind, just another data file. 
That means it can be inserted into other data files, such as word 
processing documents or database reports. In this way, you can 
combine images with text to construct a customized worksheet. 
Copies of these can be 
printed and sent to relatives 
or other researchers or taken 
on your own research trips. 
 
For those who don’t have 
image editing capacity or 
don’t want to get involved 
with it, a digital imaging 
professional should be able 
to provide these services to 
you. If you have questions or 
specific topics you’d like 
covered in future columns, 
please send email to 
cj@shoeboxscanning.biz. 
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� The regular meeting of the Indian River Genealogical 
Society was held on this date in the Main Library.  The meeting 
was called to order at 10:00 a.m. by President Cindy Davis.  
President Davis declared that a quorum was present with 81 
members and no visitors.      President Davis then recognized the 
Past Presidents that were in attendance.  We were also enter-
tained with the “Cousins Story” of Bill Wagner and Bob Poysell 
and their heritage in Logan County, Ohio. 
 
Minutes Approval:  The Minutes of the February 14, 2006, 
meeting were approved as published in the newsletter with a 
correction of the date from 2005 to 2006.  
 
Treasurer’s Report:  Ellen Stanley presented the Society’s fi-
nancial report, which was submitted for filing for audit. 
 
Vice President: Patti Kirk reviewed the scheduled Society hap-
penings in February, March and April.  Details 
on the upcoming key genealogical events in 
Chicago, Pittsburgh and Boston were pre-
sented. On Saturday, March 25, 2006, a free 
“organize your files” course will be given at the 
library.  Patti extended Happy Birthday wishes 
to Cindy and was joined by the entire audience. 
 
Corresponding Secretary:  Suzy Bromwell 
noted that she sent a card to Bill Young when 
he was in the hospital and noted her apprecia-
tion for the Society’s card at her time of family distress. 
 
Standing Committees: 
 
Education Chair:  Diane Macgowan reported the GIG’s are 
doing well. The special research days for the French Canadian 
and Swedish groups were well received.  She noted that a few 
people were inquiring about an Italian group. IRGS plans on 
continuing the 2 per month “newbee” classes.  The membership 
was thanked for their participation in the quick info question-
naire listing the states and countries they are researching.  They 
were also queried about their computer genealogy program.  
This information will help with future plans. 
 
Public Relations:  Mary Mitchell keeps trying to get placement.  
This month confused The Press Journal with the change from the 
usual second Tuesday. 
 
Program:  In lieu of Pete Kersey, Pam Cooper announced that 
they are working on the  February 2007 Seminar.  Next month’s 
program will be “Ask the Experts”. 
 
Library:   In lieu of Pat Rand, Cindy emphasized the need for 
volunteers on her committee who have knowledge of the early 
years of the society. 
 

Membership:  Co-chairs, Donna Nightingale and Marge Evans 
requested members to register any new email addresses because 
several of the present emails had bounced back. 
 
Editorial: No Report . It was pointed out by Cindy Davis that by 
downloading the monthly newsletter it was possible to do a “key 
word search.” 
 
Postcard : Ellen Stanley reviewed the activity of the postcard 
committee aimed at sending a proposal to Arcadia Publishing 
Company.   
 
Unfinished Business:  
A sign-up sheet was circulated for members to bring refresh-
ments to the meetings. 
 
Pete Kersey needs volunteers for the Church project to continue 

this ongoing project.  The information devel-
oped can be of significant interest to genealo-
gists across the US. 
A form will be circulated next month for vol-
unteers to help mentoring on a one-on-one  
basis. 
 
New Business 
The “Oral History Van” will be at the library 
from April 24 – 28.  Janie Gould conducts the 
interview with each interview lasting about ½ 

hour.  She provides you with your own CD to share with your 
family. 
 
President Davis adjourned the meeting for a refreshment break to 
share her birthday cake at 10:40 a.m. 
 
Program: The meeting reconvened at 11:10 a.m. with the intro-
duction of the program by Pam Cooper.  The program was a 
video featuring Maureen Taylor offering useful instruction for 
preparing your own Heritage Album and identifying old photos. 
 
President Davis announced that the next meeting will be the sec-
ond Tuesday, April 11, 2006, at the Main Library.  The next 
Board meeting is scheduled for April 4, 2006. 
 
There being no further business, the meeting was adjourned at 12 
P.M. 
 

Respectfully submitted: 
 

Tom Garvey 
 
: 
 
�

�-��7����34��#����
��-�����
� ��-��/	�'���'��(�



���������		
����
���
���������
�������������������� 
���

�
THE INDIAN  RIVER GENEALOGICAL SOCIETY, INC.�
�#��/��0/1��234	�
��5�/�05�&6��78/��9��:�;
2�234	 �

�3� ��34���

7*�*�3���
��

���$�

)��3�9��"#��45�

���-���AB,�

��$������)���
����53
�"�5��3"���6����"*�

�C�"7��)��93��$�

���
�
���

#�5��95�< � �"�����$�%�� �

��&5�#�5��95�< � ��������8��; �

<�5��=�5��  ���������������

�5&/�9�����5&�5<��> � �����
��%���

&/��5�#/�9�����5&�5<��> � ��
:��9���=��� �

#��<�#�5��95�<�� �������8������

�����
�	�����
��

����
�����

?5?05��6�# � �$�������.	���.���� � � #�/���?�  ������8������

59�</���� ����"����� � � � � 8�0���>��� �������� �

59=&�<�/���� $�����-�/.�=�� � � � #=08�&��58�<�/�� � ��-����-��/	��� � �
� � � �

)�����37��2�9������� ��	����DD===*�����=�<*/��DE0�� ���.� �

7����

�	�����������%���
������.�/�����/��������/*�
�������� ���0���/�����������/	��������<��

�	���������0�4������*�
-��<���	������F'&D0���������������������������

�
�����
���������G��
������

���
����2�5������
<,������������������')���,���)���,�� ������� ��%��� 
������.�/���
��/��������/*�� #�/��0�@�234	�������0���,��78�:�;
2�234	�
<,��������
�
�����'����*��,����������������
������� ���
��������,�
�,��
�
����������$����
������������
A������$)����,� '�?����<,����
����
����������$����
������������������%'
���,�'��' �'����
������ +�#�$�&����������� ����� +����
�2(��$�����
�� �

$ � � � � �- � � � � �� ��

$ � �� 3 � �	 � �� �

��������<���9"��������.��)����9��/	�

· ���������������� ���� �����!� ����
"������#�$��������% �

· ��������������& ������'�����
(���� ���!� �'�!���% �

· "���)����%� �
��
 �


